
The Villages Computer Club will meet at 1 p.m. Friday March 16th at Lake 
Miona Recreation Center.  
 
There will be a presentation by Peter Cronas/John Campbell on Taking the 
pain out of managing Passwords.  
 
Following the presentation will be refreshments, 50/50, door prizes and a 
problem-solving session.  
 
If you have a computer problem you can't resolve, fill out the problem report 
form found at thevillagescomputerclub.com and bring it to the meeting. 
 
You will also find the presentation schedule for 2012 on the web site. Please 
take a look. 
 
If you have any questions, email Paul Rabenold at TVCC.Pres@gmail.com. 
****************************************************************************************************
***** 
Interested in the New iPad, check the following websites 
All iPad 2's are $100 less and the New iPads are the same prices as the old iPad 2. 

http://www.apple.com/ipad/ 

http://news.cnet.com/8301-13579_3-57393664-37/what-you-need-to-know-

about-the-third-generation-ipad-faq/ 

http://www.cbsnews.com/8301-501465_162-57393661-501465/apples-new-

ipad-hands-on/ 

I just ordered one. 

Art Fenn - emptyvcc@gmail.com 

***************************************************************************** 
Address Book AUTO-Suggested Names 
 
Remove auto suggested names that are no longer in your AOL address book. 
 
1. Click Setup on the Buddy List. 
2. Click the General IM tab. 
3. Uncheck the USE MY ADDRESS BOOK AND BUDDY LIST TO AUTO SUGGEST 
SCREEN NAMES. 
4. Shut down and restart your AOL program. 
That name should be no longer auto suggested. 

****************************************************************************************** 

AOL 9.1 Eyeball and Later Versions 

 



On the 9.1 version of AOL there is an eyeball just to the left of SHOW EVERYONE on the 

Buddy List. Click to close the eye and then no one can see that you’re online. This prevents IM 

interruptions when you’re working on something important. 

 

On the sign on screen there is also a box that if checked makes you invisible when you're online. 

******************************************************************************

*************************** 

 
Hotmail Blind Copies To Groups 

 

In Hotmail you have 4 tabs on top when you want to send email. 

1. Select new CONTACT. Click NEW Group.  

2. Give your group a name and then list all the people under that name. Under CONTACT: 

GROUP you must type each email address separated by a COMMA. Include your own name, so 

you'll get a copy also. 

3. To send email click COMPOSE. 

4. When blank email comes up, click "TO". This will bring up "INSERT ADDRESSES".  

5. Find your group name on the list. To the LEFT of the list there will be 3 BOXES:  

TO: 

CC: 

BCC: 

Please select BCC to send all copies as blind copies.  

 

NOTE: If you do not select Blind Copies, all those addresses WILL be harvested at some 

point in time by the ‘creepos’ computers who run their computers 24/7 harvesting 

addresses from forwarded emails and selling them to porn sites, marketers,etc. All those in 

your list will start receiving huge amounts of spam. 

 

6. Click OK , write subject, write message and click SEND.  

 

Your email will be sent to each recipient with only the recipients name and your name showing. 

******************************************************************************

*************************** 

Block a Sender in Yahoo! Mail 

To have Yahoo! Mail delete all mail from a particular address automatically:  

• Select Options | Mail Options… in Yahoo! Mail.  

• Go to the Spam category.  

• Type the unwanted email address under Add a blocked address:.  

• Click Add.  



• Now click Save Changes.  

****************************************************************************** 

 

Font Default Settings in GMail 

1. Open gmail and sign on. 
 
2. Click the little Wheel at the top right of the screen, right under your gmail name 
and select SETTINGS. 
 
3. Along the top menu bar where you see General.......move to the right and click 
LABS. 
 
4. Scroll down and enable the Default TEXT,etc.  
 
5. Click Save Changes 
 
6. Click General and scroll down and you'll now see a Default Text, style,etc. 
make any changes you want and save changes. 
 
***************************************************************** 

Gmail Labels (Folders)Gmail Labels (Folders)Gmail Labels (Folders)Gmail Labels (Folders)    

 

Instead of creating folders in which to save Gmail email, you may add a label or labels to 

the email from a particular senders. You have the option also to add more than one label 

to an email. 

 

Using labelsUsing labelsUsing labelsUsing labels    
 

Labels do all the work folders do and give you an extra bonus: you can add more than one to a 

conversation. Once you've created a label, you can view all the messages with that label by 

searching, or by clicking the label name along the left side of any Gmail page.  

Create a label:  

Click the Labels drop-down menu or if you have keyboard shortcuts enabled, type l. Or, just 

click Settings > Labels. 

1. Select Create new.  

2. Type the name of your new label and click Ok 



Any selected messages will automatically be categorized under your new label. If you'd like to 

keep organized, you can remove a labeled conversation from your inbox by archiving it and view 

it later by clicking All Mail, or by clicking the label name along the left side of any Gmail page.  

To apply a label to a message, you can select the checkbox next to the message(s) in question, 

and then select the label name from the Labels drop-down menu (or you can label a single 

message while you're reading it by using the drop-down menu or the keyboard shortcut L). You 

can also drag a message to a label's name to move that message to a label. 

Edit a label name:  

1. Click the down-arrow to the left of the label.  

2. Select Rename.  

3. Enter the new label name, and click OK.  

All the messages categorized under your old label name will now be categorized under your 

new label.  

Organizing and deleting labels 

You can control which labels appear in your list on the left.  

1. Click Settings > Labels  

2. Click the show or hide link next to each label to choose whether it's listed. Or, if you see 

a label you don't need anymore, you can always click remove. (You'll have to confirm 

that you'd like to remove the label by clicking OK). 

You can also show, hide, or delete one label at a time by clicking the down-arrow to the left of 

that label.  

Use the Move to drop-down menu or the keyboard shortcut v if you want to apply a label to a 

message and move it to that label at the same time.  

*************************************************************************************************************

*** 

 

Windows Mail: Setting up an account from start to finishWindows Mail: Setting up an account from start to finishWindows Mail: Setting up an account from start to finishWindows Mail: Setting up an account from start to finish    

Windows Live Mail is for Windows 7 and Vista.Windows Live Mail is for Windows 7 and Vista.Windows Live Mail is for Windows 7 and Vista.Windows Live Mail is for Windows 7 and Vista.    

Click here: Windows Live Mail 2011  



Setting up your e-mail is a bit like setting up a new computer: You do it only once. After 

you configure your e-mail accounts in Windows Mail, you never have to hassle with it 

again—unless, of course, you open a new e-mail account. 

Windows Mail allows you to send and receive messages from multiple e-mail accounts. 

You can set up Windows Mail to work with many types of providers, from the biggest, 

most popular e-mail services all the way down to the smallest Internet service provider 

(ISP). 

Managing multiple e-mail accounts is simplified because each account in Windows Mail is 

organized in its own folder. You can check for messages from all your e-mail accounts at 

once by clicking a single button. But first, you'll need to set up each e-mail account one at 

a time in Windows Mail much as you did if you used Outlook Express. 

You can add multiple e-mail accounts in Windows Mail, and send and receive e-mail for 

all of them from one location just like you could setup different email accounts in Outlook 

Express by just clicking Tools…Accounts…ADD and enter the ISP(ex. Embarqmail.com), 

Type in the server incoming pop.embarqmail.com and the outgoing server 

smtp.embarqmail.com and check the authentication box. 

In the user box type email address jane34@embarqmail.com add the password you used for 

you embarqmail.com account 

Don’t be confusedDon’t be confusedDon’t be confusedDon’t be confused    

Before you set up Windows Mail, start by collecting the following information for each 

e-mail account. You will need to enter this information during the setup process: 

• Your e-mail address and password.  

• The type of e-mail server your e-mail service uses.  

• The address of the incoming and outgoing e-mail servers used by your e-mail 

provider. 

Most people know their e-mail addresses and passwords, but many people get confused 

when asked to enter information about e-mail servers. This is easiest if you gather some 

basic information from your e-mail provider before you begin adding accounts in Windows 

Mail. 



EEEE----mail server typesmail server typesmail server typesmail server types    

Windows Mail supports three types of e-mail servers. You don’t need to understand the 

details about these server types; you just need to find out which one your e-mail service 

uses both for incoming and outgoing e-mail: 

• Post Office Protocol 3 (POP3) servers. Most e-mail services and ISPs use this type of 

server, especially for personal e-mail accounts. They hold incoming e-mail messages 

until you check your e-mail, at which point they're transferred to your computer. 

Messages are typically deleted from the server when you check your e-mail.  

• Internet Message Access Protocol (IMAP) servers, such as AOL. These servers let you 

work with e-mail messages without downloading them to your computer first. You can 

preview, delete, and organize messages directly on the e-mail server. Copies are stored on 

the server until you delete them. IMAP is commonly used for business e-mail accounts.  

• Simple Mail Transfer Protocol (SMTP) servers. This outgoing mail server handles the 

sending of your e-mail messages to the Internet. An SMTP server handles only the 

outgoing e-mail, and is used in conjunction with a POP3 or IMAP incoming e-mail 

server. 

Incoming and outgoing eIncoming and outgoing eIncoming and outgoing eIncoming and outgoing e----mail serversmail serversmail serversmail servers    

Once you know the type of e-mail server used by each of your e-mail accounts, you must 

find out the address of its incoming and outgoing e-mail servers. During the setup process, 

Windows Mail requires you to enter the address of each e-mail server. There are only two 

types of incoming servers to choose from: POP3 or IMAP. 

Before you set up an e-mail account in Windows Mail, you need to know the address of 

the incoming and outgoing e-mail servers used by your e-mail provider  

POP3 is by far the most common type of incoming e-mail server for personal e-mail 

accounts. And SMTP is the only type of outgoing e-mail server that works with Windows 

Mail, so you normally don’t even need to check the outgoing server type with your e-mail 

provider. Practically all personal e-mail accounts—with the exception of web-based 

e-mail—use an SMTP server for outgoing e-mail. 

E-mail server addresses usually have the same format. Most ISPs (named “myisp” in this 

example) have server addresses like this: 



• Incoming server: pop.myisp.com (or imap.myisp.com, if they use an IMAP server)  

• Outgoing server: smtp.myisp.com 

You can usually substitute the name of your ISP in place of myisp in the example above. If 

this doesn’t work, check with your ISP. Questions about e-mail server addresses are 

among the most common inquiries e-mail providers get, so they usually have this 

information posted in the support section of their websites. 

Here are server addresses for some of the most popular e-mail services: 

• Yahoo!: pop.mail.yahoo.com (incoming) and smtp.mail.yahoo.com (outgoing)  

• AOL: imap.aol.com (incoming) and smtp.aol.com (outgoing)  

• Gmail: pop.gmail.com (incoming) and smtp.gmail.com (outgoing)  

• Embarqmail: pop.embarqmial.com and smtp.embarqmail.com  

Finally, you must know whether your outgoing e-mail server requires authenticationauthenticationauthenticationauthentication, since 

there is a check box for this when you set up a new e-mail account in Windows Mail. If you 

can’t find out the answer from your e-mail provider, try sending a test message with the 

check box selected and another one with the check box cleared, to see which works. 

Note: Several years ago Comcast had Outlook Express users change their port from 25 to port 

587. If you’re using Win Live Mail and having trouble sending email, try changing the port from 

25 to 587. This has worked for some Win Live Mail folks with problems. 

Note2:Some e-mail services, such as Yahoo! Mail, require a premium subscription for POP3 

access. 

WebWebWebWeb----based ebased ebased ebased e----mail and Windows Live Mailmail and Windows Live Mailmail and Windows Live Mailmail and Windows Live Mail    

Many people want to know if they can send and receive Windows Live Hotmail in 

Windows Mail. The answer is ‘NO’ , Windows Mail does not support the HTTP servers 

used by Hotmail and other web-based e-mail services. 

However, you can set up Hotmail and other web-based e-mail accounts to work with 

Windows Live Mail. This allows you to store and read Hotmail messages even when you 

are not connected to the Internet. 



Windows Live Mail includes the familiar features of Windows Mail, the mail program 

included in Windows Vista, plus new features such as the ability to automatically enter the 

correct settings for e-mail servers used by popular e-mail services, including Windows Live 

Hotmail, Yahoo!, AOL, and Gmail. 

Windows Live Mail also works with e-mail services from other e-mail providers and ISPs, 

although you will have to configure those accounts manually. 

To download Windows Live Mail, go to the Windows Live Mail website.  

 

Step by stepStep by stepStep by stepStep by step    

Once you have collected the required information for each e-mail account, you can start 

setting up Windows Mail. Here’s how to add an e mail account in Windows Mail: 

1. Open Windows Mail by clicking the Start button , clicking All Programs, and then 

clicking Windows Mail.  

2. Click the Tools menu, and then click Accounts.  

3. Click Add. 

After you click Add on the Internet Accounts screen, Windows Mail will ask what 

type of account you want to add 

4. Click E-mail Account, click Next, and then follow the instructions. 

After you are done entering all the information for one e-mail account, repeat the process 

for each e-mail account you want to set up, if you want to add more than the one account. 

NoteNoteNoteNote    

During setup, you'll be asked to pick a display name. You might want to enter your actual 

name here rather than your e-mail address, since this is the name that recipients will see 

when you send them an e-mail message. 

Importing your e-mail, & contacts,into Windows Live Mail 



Ready to install Windows 7? Great! One thing you'll need to know before you begin, though, is that some 

familiar programs—like Outlook Express, Windows Mail, Windows Calendar, and Windows Address 

Book—aren't included in this version of Windows. But don't worry, you've got a couple of new options 

for getting to your e-mail, contacts, and calendars. 

You can use a free online service like Windows Live, which is a convenient way to go because you can 

access all your information from any computer with an Internet connection. 

But if you want to have all your data on your PC even when you're offline, you'll need to install a new 

desktop e-mail program, such as Windows Live Mail, part of Windows Live Essentials, a free suite of 

programs designed to link what you do on your desktop with what you do online.  

Once you've installed Windows Live Mail on your PC, you'll be able to import your existing e-mail 

messages, calendars, and contacts from Outlook Express (if you're upgrading from Windows XP or earlier) 

or Windows Mail (if you're upgrading from Windows Vista). You can also set it up to work with Hotmail 

and other e-mail providers—like Gmail, Yahoo! Mail Plus, or your Internet service provider (ISP)—to keep 

track of all your e-mail accounts in one place. To learn more about Windows Live Mail, see So long, 

Outlook Express! 

Making the switch to Windows Live Mail 

The steps you'll need to follow to get started with Windows Live Mail will depend on what type of 

Windows 7 installation you're doing—an upgrade or a custom installation. To find out more about 

installing Windows 7, see Installing and reinstalling Windows 7. To download Windows Live Mail, go to the 

Windows Live Mail website. 

Error! Hyperlink reference not valid.  

 If you're upgrading to Windows 7 from Windows Vista

Using the Upgrade option during Windows 7 installation will keep your files and settings from Windows 

Vista in place—including your e-mail, contacts, and calendars. Then, when you start Windows Live Mail for 

the first time, it will automatically import your data. 

If you're already using Windows Live Mail in Windows Vista, good news: You won't have to do anything 

special to get up and running after you finish upgrading to Windows 7. Just open and use it as you 

normally do. 

 If you're doing a custom installation of Windows 7

Choosing the Custom option during installation doesn't preserve your programs, files, and settings. That 

includes your e-mail, contacts, and calendars—whether you're using Windows Mail, Outlook Express, or 

another program. So you'll need to back up your e-mail, calendars, and contacts—along with any other 

files and settings you want to preserve—by copying them to an external hard disk or a USB flash drive. 



We recommend using Windows Easy Transfer, a free download, to do this backup. If you're upgrading 

from Windows XP, see Upgrading from Windows XP to Windows 7. If you're upgrading from Windows Vista, 

see Upgrading from Windows Vista to Windows 7 (custom installation). 

After Windows 7 is installed on your PC, you can use Windows Easy Transfer again to move all your files 

and settings back to your computer. Then, after you download and install Windows Live Mail, you can 

import your data. 

Top of page 

Importing e-mail and contacts into Windows Live Mail 

After you've moved your e-mail and contacts from the external hard disk or USB flash drive back to your 

PC and installed Windows Live Mail, you're ready to import your data into Windows Live Mail. 

Error! Hyperlink reference not valid.  

 To import e-mail

1. Open Windows Live Mail by clicking the Start button . In the search box, type Windows Live Mail, 

and then, in the list of results, click Windows Live Mail. 

2. Click the File menu, and then point to Import.  

3. Click Messages, and then choose the e-mail program from which you want to import e-mail 

messages. 

4. Click Next, and then follow the on-screen instructions. Your imported messages will appear in the 

folder list under Storage folders. 

 To import contacts

1. Open Windows Live Mail by clicking the Start button . In the search box, type Windows Live Mail, 

and then, in the list of results, click Windows Live Mail. 

2. In the lower-left corner of the Windows Live Mail window, click Contacts. 

3. Click the File menu, point to Import, and then click the type of address book that you want to import. 

If prompted, browse to the file that contains the contact information that you want to import, click 

it, and then click Open. 

*************************************************************************************** 

Enjoy the beauty of nature on time lapse photography................ 

EACH FLOWER IS FILMED FOR TWO DAYS AND 



PHOTOS ARE COLLATED WITHIN 7 MINUTES TO GET 

THIS EFFECT. 
Clic aquí: La vida de Las flores

******************************************************************************

*********************** 

Remember Susan Boyles???? 

http://www.youtube.com/watch?v=VSrAJsWvEIc&feature=relat

ed 

http://www.youtube.com/watch?v=8JtAz1gnvBM&feature=relat

ed 

******************************************************************************

****** 

www.youtube.com/watch_popup?v=VxHfYNTrnic 
************************************************************************************ 

Driving in the rain -- this may 

save your life !!!  

 

 

GOOD VISION IN A DOWNPOUR  

 

How to achieve good vision while driving during a heavy 

downpour.  

 

We are not sure why it is so effective; just try this method 

when it rains heavily. This method was given me by a Police 

friend who had experienced and confirmed it. It is 

useful....even driving at night. One method used by 

Canadian Military Drivers for years. 

 

Most of the motorists would turn on HIGH or FASTEST 

SPEED of the wipers during heavy downpour, yet the 



visibility in front of the windshield is still bad...  

 

In the event you face such a situation, just try your SUN 

GLASSES (any model will do), and miracle!!! All of a 

sudden, your visibility in front of your windshield is 

perfectly clear, as if there is no rain !!!  

 

Make sure you always have a pair of SUN GLASSES in your 

car, as you are not only helping yourself to drive safely with 

good vision, but also might save your friend's life by giving 

him or her this idea...  

 

Try it yourself and share it with your friends!!! Amazing, 

you still see the drops on the windshield, but not the sheet of 

rain falling. 

 

You can see where the rain bounces off the road. It works to 

eliminate the "blindness" from passing semi's spraying you 

too.  

 

Or the "kickup" if you are following a semi or car in the 

rain. They ought to teach that little tip in driver's training. 

It really does work... 

 

This next warning is a another good one! 

I wonder how many people know about this:  

 

A 36 year old female had an accident several weeks ago and 

totaled her car. A resident of Kinburn, Ontario was 

traveling between Kinburn & Ottawa. It was raining, 

though not excessively, when her car suddenly began to 



hydro-plane and literally flew through the air. She was not 

seriously injured but very stunned at the sudden occurrence! 

 

When she explained to the OPP Officer what had happened 

he told her something that every driver should know - 

NEVER DRIVE IN THE RAIN WITH YOUR CRUISE 

CONTROL ON. She thought she was being cautious by 

setting the cruise control and maintaining a safe consistent 

speed in the rain. But the Officer told her that if the cruise 

control is on when your car begins to hydro-plane and your 

tires lose contact with the pavement, your car will accelerate 

to a higher rate of speed making you take off like an 

airplane. She told the OPP Officer that was exactly what had 

occurred.  

 

The Officer said this warning should be listed, on the 

driver's seat sun-visor - NEVER USE THE CRUISE 

CONTROL WHEN THE PAVEMENT IS WET OR ICY, 

along with the airbag warning. We tell our teenagers to set 

the cruise control and drive a safe speed - but we don't tell 

them to use the cruise control only when the pavement is 

dry.  

 

The only person the accident victim found, who knew this 

(besides the officer), was a man who had a similar accident, 

totaled his car and sustained severe injuries.  

 

NOTE: Some vehicles (like the Toyota Sienna Limited XLE) 

will not allow you to set the cruise control when the 

windshield wipers are on. If you send this to 15 people and 

only one of them doesn't know about this, then it was all 



worth it. You might have saved a LIFE !!! 

******************************************************************************

******** 

Wake up America !!!!!! 

 

This is why voter I.D. is sorely needed. 

 

You do not have to watch it all but the first few minutes will show how wacked out Minnesota is 

in voter registration.  

http://www.youtube.com/watch_popup?v=GqMVxeZhflI&feature=player_embedded! 

Given the importance of voting, this video points out how easily a Marxist might be 

elected thru concerted crime,  

as in ACORN for example on the Left, and other collusion on the Right.... 

Doesn't matter which, only that concentrated fraud can easily occur when 

identification is not a factor!  

Take a gander at this video proving that election fraud is easy in Minnesota and 

possibly elsewhere. 

JmaxJmaxJmaxJmax  

Jmax's Website http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  



 


